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Introduction to tally systems and to TallyMan 
 
Not so many years ago tally/cue systems in a television production control area were very 
basic with perhaps only a 24 volt lamp on the monitor providing the on-air information.   
 
Cue information was also sent to the camera’s so that both the artist and cameraman would 
know when that camera was taken live on the mixer.  
 
The only concession to a mnemonic or name under the monitors was camera tape with Tom, 
Dick or Jane written on it.  
 
Relays were used with contact closures-to-ground from the vision mixer (switcher) and re-
mapping tally lights to different monitors was out of the question. 
 
During 1988, TSL thought there must be a better way as some tally/relay systems were 
becoming very cumbersome.  Often the tally cue system was left to the end of a project with 
the additional resulting pressure to get larger and larger relay based systems working. 
 
Software control had to be the way forward as users were now demanding more sophisticated 
tally control with a naming facility for the various router and mixer sources. 
 
With the rapid development of large studios, multi-channel play out systems and in particular, 
large outside broadcast vehicles, sophisticated Tally and UMD control has become essential.  
 
Tally systems are now considered as essential communications.  They are crucial to the 
operation. 
 
With large monitor stacks (walls) in use, a naming system for the picture sources has become 
essential and a Tally and Under Monitor Display (UMD) System must be able to read router 
status information. 
 
In addition, many control areas are now specifying multiviewer type units; the pictures often 
displayed on a plasma screen and a tally system has to be able to interface to these units. 
 
TSL’s current systems have the ability to accept serial tally and parallel tally information from 
one or more mixers and/or from General Purpose Interfaces (GPIs) and mnemonic or status 
information from several routers – all at the same time. 
 
The TSL systems can cope with all these requirements and a range of UMDs are available for 
all monitors. 
 
For a simple tally requirement, consider a system for an outside broadcast vehicle. 
 
A large outside broadcast vehicle might have two vision mixers, a SD and an HD mixer.  
Tallies are required from both and possibly from several banks of the mixer(s). 
 
The routing facilities could be a router with several levels or two or more separate routers 
might be used.  The status or cross-point information needs to be known for all relevant levels 
from all routers if the monitor stack (wall) includes UMD with the picture monitors or 
multiviewer displays for the various sources and destinations. 
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The cameras need to be tallied - i.e. the red light needs to be lit -  to indicate to both the 
cameraman and the artist that the camera is on-air.  These days it is very common for two 
types of tally to be fed to the cameras. 
 
The camera may be taken to air on the mixer directly (from the CCU) or via a router feeding 
the mixer inputs and it might also be continuously recorded on a server or tape machine for 
alternative camera shots; behind the goal type of coverage. 
 
These two types of tally have become known as red and green (or Iso) tallies respectively. 
So, for example, if an Aux Bus on the SD mixer is providing the video feed to a VTR for iso-
recording, the cameraman needs to know that (no “nodding” on air when the director issues 
instructions to the cameraman over talkback!) so a green tally needs to be routed out of the 
tally system to the cameras.  This will be in addition to the red tally derived from the Mixer 
PGM bus information. 
 
The VTR operator may also need to know that the Vision Operator has selected Camera 1 on 
an Aux Bus as his iso feed.  He too, will have a UMD associated indicating VTR status and 
program feed. 
 
The monitor stack (wall) may have several monitors assigned to the router destinations.  With 
the growing trend for more and more sources to be monitored, multiviewers feeding plasma 
displays are becoming common in trucks. 
 
Most multiviewers have the capability to show text and tallies so these may in effect be 
treated as separate monitors with their associated UMD. 
 
Single screens may incorporate their own tally lights but more likely they will have a UMD 
underneath or embedded into the picture area (IMDs) which will include tally lights.  The tally 
lamps on this IMD/UMD should show when the camera is taken to air and also when the 
camera is being Iso-recorded. 
 
Very often tallies will need to be taken to other vehicles or output as GPIs on the tailboard of 
the vehicle.   
 
Relay outputs are the safest route to avoiding circulating ground current problems and by the 
same token, GPIs coming in from a source external to the truck and its electricity supply may 
be provided by using opto-isolated inputs. 
 
In  large OB fleets, several vehicles may be used for major events and tally and router 
information in one truck may need to be seen in other trucks.  A simple RS422 or CAT5 cable 
link is all that is required for this networked TallyMan facility. 
 
Taken all together, the tally system is likely to be quite complex and certainly very important. 
 
TSL, as a large system integrator with many hundreds of installations, has found that an 8 
character, tri-colour display with separately addressable tally lamps meets the majority of 
requirements.  There are occasions where longer mnemonics or messages are required and 
16 character displays are available deal with this. 
 
TallyMan can deal with all these requirements and have the ability to be reconfigured merely 
by loading a prepared file that holds the new UMD mnemonics, tally mapping and initial router 
assignments for the particular show. 
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TallyMan 
 
To meet the need for an easily updated tally system, TSL developed TallyMan.  This program 
builds on the experience gained from the original class-leading TSL Winsoft configuring 
program. 
 
The TallyMan program will have a familiar look to it as it mimics the familiar Windows 
directory and file view as seen in Explorer or My Computer. 
 
All system components may be changed at will and the program is virtually infinitely 
expandable up to the capacity of the computer hardware that is used as the platform. 
 
It is now becoming common for sophisticated gated tally mappings to be made, especially on 
OB trucks.  In TallyMan, for example, it is possible to AND, OR (or any other logic function) 
tallies together. 
 
A major feature of TallyMan is the ability to have up to 16 channels of tallies.  Tallies may 
therefore be assigned to any of the 16 tally channels available.   
 
Previous programs / systems (e.g. TSL’s Winsoft) have often provided two tally channels 
such as red and green.   
 
Note about twin tallying: 
 

In some circumstances, both a red and a green tally might have been linked to a router 
source via the tallied router buses – one bus has  a red tally as it goes to air and another 
bus has a green tally assigned to it as it feeds a VTR for, say, behind-the-goal-action.   
 
Both router buses may select the same source and the red and green tallies, when 
mapped from the same red/green tallied router source to different output pins via a 
software filter or mask in the set-up program, allow the cameras to receive separate red 
and green tallies. 

 
In TallyMan, this tally channel idea is extended from 2 to 16 channels. 
 
In addition, TallyMan uses System Tallies.  These are tallies that may be made from other 
tallies, possibly using logical operators such as AND, OR etc. to determine how the tally 
output from the System Tally behaves.   
 
A  System Tally may be likened to a “multicore cable” or “wrapper” which can carry several 
tallies and tally channels.  In this analogy, these tallies are the individual wires of the multicore 
cable,  
 
Several tallies may be assigned to a System Tally that “belong” to different Tally Channels 
An output mask must be selected that will determine which input tallies are allowed through to 
the System Tally output.  This allows for rapid program by program changes. 
 
UMD Control 
 
Full colour control of the UMDs may be may from within the program and sophisticated colour 
control is possible via tally signals. 
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The following is intended to give a good overview of TallyMan – it does not replace the 
detailed information that is found in the manual. 
 
 
System interface Lists 
 
TallyMan can interface to all of the following: the list is not exhaustive. 
 
TallyMan Mixer/Switcher support as at April 2008  
 
GVG Kalypso – Ross 
Thomson ACOS DD35 
Sony Serial Tally 
Snell & Wilcox 
GVG M2100 
Sony Extended Protocol 
  
Routers: 
 
TallyMan Router support as at April 2008  
        
        
Protocol   Control   Alphanumeric 
        
BTS ASCII   Yes   No  
GVG Native   Yes   From Router 
BTS ESSwitch   Yes   From Router 
Kramer   Yes   No  
Leitch   Yes   No  
Network   Yes   No  
NVision   Yes   From Router 
Pesa   Yes   From Router 
Quartz   Yes   From Router 
SBUS (ROT16)   Yes   From Router 
Sigma   Yes   No  
Sony   Yes   No  
SWP02   Yes   No  
SWP08   Yes   From Router 
Talia   No   No  
VikinX   Yes   No  
       
 
TallyMan Displays support as at April 2008  
 
TSL UMD (Most Multiviewers use this). 
Early Zandar DX Multiviewers 
Barco Vivaldi I 
Barco Vivaldi II 
Frens UMD 
Thomson BTS ASCII 
Barco Hydra 
 
 
 
When a new mainstream equipment is released the protocol / equipment type will be added to 
this list.  This means that TallyMan upgrades will automatically offer greater connectivity. 
 
New TallyMan versions on the TSL web-site will often include new protocols.
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Programming Facilities 
 
Tally Control 
 

·  Sixteen tally channels or “tally families” allow easy and logical tally assignments to 
UMDs, router destination/sources and output pins for the cameras.  

·  Provision for System Tallies consisting of internal “Boolean” tallies.  These are 
defined combinations of other ordinary tallies (in or out) 

·  Ability to use independent three colour control of the TSL UMDs 
·  Ability to inhibit the left or right tally on any UMD. 
·  Ability to map tallies to router sources. 
·  Ability to map tallied router sources to a tally o/p pins for the cameras. 
·  Ability to map tallies to router buses. 
·  Ability to map tallied router buses to a tally o/p pins for cameras or other external tally 

lights etc. 
·  Isolated relay-contacts for the parallel tally outputs by using ESP-1R . 

 
Mnemonic Control 
 

·  All mnemonics can be of variable length. 
·  Easy mnemonic control of the dynamic UMDs. 
·  Drag and drop from mnemonic lists. 
·  Ability to import mnemonics lists (e.g. from Excel) for router sources and destinations 

(buses). 
·  Provides individual display control over tie-line recursion depth where routers are 

cascaded. 
·  Control of individual UMD mnemonic and tally LED colour and mnemonic justification, 

either singly of as groups. 
·  Ability to map cascaded routers so the o/p UMD shows the correct source mnemonic. 
·  Router source to source and source to bus mapping possible. 
·  Multiviewer support. 
·  External router control from TallyMan. 
·  Snapshot of router status may be taken and saved in a file 
·  Downloading the names lists from some routers into TallyMan for display on the 

UMDs - where supported by the router manufacturer. 
·  Uploading of UMD mnemonics from TallyMan into the router’s names lists – where 

supported by the router manufacturer. 
·  Uploading of mnemonics from TallyMan into the switcher’s / mixer’s panel – where 

supported by the mixer manufacturer. 
 
 
General 
 

·  Password control is offered allowing the configuring engineer to offer a fine level of 
control to less experienced users on a day to day basis. 

·  TallyMan is configured by a standard PC running Windows 95, 98, NT4, 2000 or XP,  
·  Configuration of system components can be done “live” on the system. 
·  Router sources and destinations may be sorted according to type (OS lines, 

Cameras, VTRs etc) 
·  All current interfaces for various routers, mixers etc. are available and updateable via 

a flash update of the TMx unit 
·  All system objects can be named for easy reference. 
·  GUI on the computer monitor gives a representation of the actual monitor stack or 

wall. 
·  There is the ability to save and open different configurations  (Tally, Mnemonics and 

router mapping details).  All parameters are saved in one file. 
·  Names lists may be entered for tallies, routers and Controllers as “aide-memoirs”. 
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Getting Started 
 
Connecting together. 
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Important - Changing the IP address to match the system scheme if necessary. 
 
Connect a PC running HyperTerminal (for example) to  the Mtce / Port 3 on the TM1. 
 
HyperTerminal Settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Start HyperTerminal and then power up the TM1 and wait for about 10 secs. Press Y on the 
keyboard within 1 sec of the message appearing. Follow the on-screen instructions 
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·  Pressing S or Enter on the PC’s keyboard will set the TallyMan units as the Main Unit 

For stand alone units this is what you want. 
·  Pressing C will set it as a Controller so that it may be an Object in the system tree 

under a Main Controller for large systems. 
·  Pressing B will set the unit as a Redundant Backup unit.  See the section on Backup 

in the main manual for information on how to use this facility. 
·  Pressing D  will delete the current setup file; pressing any other key will allow access 

to the IP settings. 
·  Pressing Y will revert the unit to factory software and will downgrade the unit to the 

previous version of the TallyMan Program provided that an upgrade has taken place 
in the field. 

·  IP Addresses are set as shown.  If no entry is made and the Enter key on the PC’s 
keyboard is pressed, the original settings will be kept. 

 
When all settings are correct remove the RS232 cable and re-power the unit. 
 

Notes. 

 
When using a TMx with a RS232 card fitted in the Control 3 position use the following cable: 
 
PC    -  TMx 
Pin 2 – Pin 3 
Pin 3 – Pin 2 
Pin 5 – Pin 5 
 
 
When using a TMx with a RS422 card fitted in the Control 3 position use the following cable: 
 

PC    -  TMx 
Pin 2 – Pin 2 
Pin 3 – Pin 8 
Pin 5 – Pin 4 
 
Next, place the CD in the tray and search for the TallyMan program directory.  Double-click on 
 

���������  
 
to start the auto install. 
 

·  A shortcut will be placed on the desktop for the tallyman.exe file.   
·  Find the  correct TMx set up file (Either for a TM1 or TM2) on the CD and copy it to 

the TallyMan directory on the configuring PC.  This will automatically set the correct 
IP address in the program for the TMx box as set by the factory. 

·  Run the program.   
·  Open the correct TMx Set up file for the platform in use, found on the supplied CD 

ROM once the program is running.   
·  Connect to the TMx as this file contains all the correct IP parameters.  

 
Go Off-line and you are now in a position to add objects such a mixers/switchers, routers and 
multiviewers. 
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Notes and tips.   
 

1. If you cannot connect with the PC to TallyMan, the PC may well be on a different IP 
group / subnet mask to TallyMan.  Make sure that the PC has a fixed IP address set 
and that it is in the same group as the TallyMan unit. 

 
2. When making changes to any object, check that the serial port setting number has 

not changed as shown in the Communications dialog box. 
 

3. Use a RS422 LED data checker if you have no communication as evidenced by not 
tally indication in Tools > Tally Mimic or Tool > Router Mimic when On-Line.  This will 
show immediately any wiring errors – the cause of most communications problems. 

 
4. Look for the rear RJ45 UMD data port LEDs winking, showing correct UMD activity. 

 
5. If a corrupt file is suspect it may be deleted via the HyperTerminal route. 

 
6. When programming it will be found very helpful to enter the Names of the various 

tallies, router sources etc at an early stage. 
 

7. Check the main manual for the UMD function descriptions: ie, Fixed Mnemonic, 
Follow Matrix Destination, etc. 

 
Initial Configuration. 
 
Once you have the correct initial file on the PC it is recommended that you add the Objects 
(Mixer, Router etc.) in the following order.  This is not mandatory but may help with the 
configuration. 
 

1. Set the correct platform (TM1, TM2) 
2. Add the Mixer 
3. Add the Router 
4. Add any extra UMD drivers that may be needed. 

 
A few key requirements are now described. 
 
The method of adding components/objects is the same for all objects: 
 
Click on Add New Component on the main screen. 
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From the Add New System Component list select the Object to be added. 
 

  
 
 
 
 

  
 
 
When the protocol type has been selected, press Apply.   
 
Then set the Main Communication under Assign Interfaces. 
 
 

When a new 
component is 
added to the 
system it must be 
given a Name 
before the OK 
button becomes 
active. 
 
This Name will be 
seen in the 
system tree on the 
left side of the 
screen. 

The protocol type 
is selected from 
the drop down box 
and here is shown 
as type GVG 
Kalypso.  Press 
Apply. 
 
The Size will be 
set for some 
mixers/routers – if 
they are not set 
enter the 
appropriate 
number in the 
Size box. 
 
The Mixer/Router 
Sources and 
Destinations are 
seen in the LH 
column. 
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The Port Number refers to the hardware port on the rear of the TallyMan unit.  The 
Description text is optional. 
 
The Serial Parameters will be automatically filled for the manufacturer’s default settings.  
These may be changed, if necessary. 
 
Some mixers and router will be connected via an IP link.  This method, where allowed, is 
shown on the Type drop-down box. 
 
 
For the Mixer:   
 
Mixer Program Tally to Mixer Source Mapping.   
 
A Program Tally module is usually provided for each mixer.  These Program Tallies should be 
set to the Mixer Sources 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Mixer Program Tally. 
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Add the Program Tally to the source. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is the linking in TallyMan.  The box below indicates the TallyMan object.  The video path 
is indicated only to show that the tallies may be regarded as running in the opposite direction 
to the actual video. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mixer Module 

Video 

Tally 

Map the appropriate Program 
Tally In to the appropriate Mixer 
Source in TallyMan  
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Adding Router modules 
 
 
Add a router in the usual way to the TallyMan tree. 
 
If the router destination(s) are linked to the Mixer inputs set this link in TallyMan from the 
Mixer Source screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the router is a monitoring router set the Mixer Source to the Router Source in Source to 
Source mapping from the Mixer Edit Source screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Tip:   
 
Either the Name or the Mnemonic may be selected to show here from the View > Options  
menu item
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In more detail: 
 
The router source may be mapped to:  
 
·  A router source – source to source mapping 
·  A router destination – source to destination mapping 
 
With source to source mapping, a Separate Mnemonic may be set which is the Mnemonic 
shown on this screen.  All tally mapping will be dynamic but the mnemonic will stay as shown 
in the box with the green text at the top of this screen. 
 
 

 
 
 
 
Assign to Source 
 
When this option is selected in the Assignment box,  a Display on the second router output  
will show the mnemonic and tally state of the assigned source.  In this example, “CAM 1” will 
be shown, assuming that the Router 2 Bus has selected its input, SRCE 129. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
             

Router 1 
Lines 

Router 

Router 2 
Main 

Router 

CAM 1 

CAM 1 

SRCE 129 SRCE 193 

TallyMan Link 
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The mnemonic for the input to Router 2, SRCE 129, is effectively taken over by the input 
mnemonics of Router 1.  In this example, the mnemonic shown on the UMD will be those for 
SRCE 193.  Tallies from either source will be shown. 

Therefore, in this example, only the mnemonics for Router 1 need be entered in the 
mnemonics lists.  

(Source to Source mapping may also be done within one router). 

An exception to this is when the Separate Mnemonic box is checked.  Although the tallies 
will effectively be added together, the mnemonics will be kept separate. 
 
 
Multilevel Routers 
 
If a source is assigned to a destination, it is possible to specify a particular Level for the 
assignment.   
 
Leaving the Level set to Normal means that any UMD assignment will take its selected level 
and path through TallyMan. 
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Assignment to Destination  
 
 

  
 
 
 
This is used when there is more than one router in the system and displays need to show the 
correct original source mnemonic. 
 
 
 
 
 
 
 
 
 
 
 
A display on the Main Router bus needs to show the correct Lines Router source mnemonic. 
 
In the example above, Router 2 is the final Router in the chain.  Input 1 on Router 2 has the 
mnemonic “SRC 129”.   

This input 1 is connected to Router 1, Bus 1, which has the mnemonic “DST 161”.  Router  1 
will also have mnemonics assigned to it’s sources.  

It is these source mnemonics that will be shown on the Router 2 Bus Display.  

 
Therefore, the linking will now ensure that the Router 2 Bus Display shows the correct Router 
1 source mnemonic which is selected by Router 1, Bus 1. 

  
    

Router 1 
Lines 

Router 

Router 2 
Main 

Router 

CAM 1 DST 161 
CAM 1 

SRC 129 

TallyMan Link 

The Category is 
shown as OS – 
Outside Source. 
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Tallies to UMDs 
 
If UMDs (or multiviewer displays) are assigned to either router destinations or sources they 
will display tallies via that path.  This explains why it is important to get the mixer to router 
linking correctly carried out. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Tallies may also be set directly to the UMD and may add or be Exclusive to any router-
derived tallies. 
 
 
 
Set the Tally Channel mask to allow tallies through.  A System Tally (see main manual) may 
contain tallies that belong to various channels.  Be sure to select these channels in the mask 
if you want them displayed on the UMD. 
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Tally Outputs to Cameras 
 
The tally outputs to the camera CCUs are available on the D37 connectors. In the TMx units 
these are Open Collector circuits. 
 
Choose an output tally pin and map input tallies to it – usually a router source if there is a 
router in the system. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It will be seen that any router switching or input-to-mixer changes will automatically allow the 
correct CCU tally signalling if this tally mapping method is followed. 
 
 
Note: 
 
Many camera CCUs will take Open Collector signalling.  An exception is the current range of 
Thomson Cameras.  Here, isolated relay closures are required so an additional relay unit from 
the TallyMan range is required, the ESP-1R. 
 
 
 

 
The full manual should be used as the reference document as TallyMan allows 

sophisticated tally control along with router switching and Names into mixer panels etc. 
 


